
These technical notes describe the enhancements and/or 
corrections made to the software and are presented here with the 
most recent changes listed first. We welcome your comments and 
suggestions on the WEB at http://www.microkinetics.com/ 
*************************************************************** 
 
TurnMaster Pro 2014 for Windows 
 
 
 Date: March 24, 2014 
 Subject: Enhancements resulting in revision 6.0.005 
 By: Jeff Kidd 
 
 

1. Improved the speed of drawing the graphics of large CNC programs 
with numerous small circles and lines. 
 

2. Corrected the labels of "Start of Taper (X-Axis)" and "End of 
Taper (X-Axis)" on the Taper & Arc Roughing screen, which were 
reversed. 
 

3. Modified labels on the Taper & Arc Roughing screen to better 
reflect whether Taper or Arc was selected. 
 

4. Enlarged the drawing area on the Wizards | Threading screen. 
 

5. Added Feed Rate Scale to the Machine Parameters screen.  All 
commanded feed rates in the G-code program will by multiplied by 
this number.  The allowable values are between 0.1 and 100.  The 
default is 1. 
 

6. Corrected a problem when using a Tool Turret with multiple tools 
at the same station.  Switching between these tools using the M06 
would sometimes give an erroneous error message. 
 

7. Corrected the erroneous display of "Invalid Tool Number ..." 
during an M06 command if the selected tool did not have a textual 
description.  
 

8. Corrected a problem with the graphics after a tool change.  
Sometimes, the next tool radius was used when drawing the last 
move before a tool change. 
 

9. When entering a Drill as one of the tools in the Tool Chest, 
assume the diameter is entered instead of the radius.  For all 
non-drill tools, the radius is assumed. 
 

10. Improved the graphics when using a Drill tool.  Since a drill 
comes in from the side, it should not color a radius around the 
final tool position. 
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11. Modified the CNC display to highlight the 4th line (instead of 
the 3rd line) if the text size is small. 

 
12. Corrected a problem with the Diagnostics process.  Occasionally, 

the Ramped Move test would terminate before reaching maximum 
motor speed.  This would result in a recommended Ramped Move 
Speed lower than it should have been. 

 
13. Added "Write Default VFD Settings" button on Machine Parameters 

screen, Serial Spindle tab.  This button enabled for the Teco 
7300 VFD only.  When pressed, all default parameters stored in 
the  file, MK Lathe 1236.CV7 will be sent to the Teco 7300 VFD.   

 
    MK Lathe 1236.CV7 is now included in the installation package. 
 
14. When using a Tool Turret, the turret position will be set to the 

(Tool # mod 20).  For example, Tools 2, 22, 42, 62, and 82 will 
all use turret position #2, but can have different X and Z 
offsets.  This feature enables multiple tools to be mounted at a 
single tool turret position. 

 
15. Improved the wording on the Teco 7300 VFD communication error 

message box to provide clearer and more useful information. 
 
16. Improved the reliability of the Get Settings button on the 

Machine Parameters screen, Serial Spindle tab.  
 
17. If a Teco 7300 VFD is attached, but no MN400 controller is 

connected, give the user the option to operate the VFD only 
using the Spindle button on the main form. 

 
18. Corrected a problem with Tool Name descriptions, which were 

being converted to all lower-case. 
 
19. Corrected a problem when a G25 (Call Subroutine) command.  If an 

invalid subroutine name was entered, the CNC program would be 
erroneously truncated. 

 
20. Added "Init as Start" and "Return to Start" buttons on the MN400 

Jog Screen.  These buttons perform the same functions as the 
corresponding buttons on the Main Form's toolbar. 

 
21. The installation process now adds the RunCNC.exe file which will 

be the default program for .CNC files if TurnMaster Pro and 
MillMaster Pro are both installed.  This small program decides 
which program to launch (TurnMaster or Millmaster) if a .CNC 
file is double-clicked. 

 
22. Added the read-only variable TM_ToolNum, which returns the 

currently active tool number (1-99). 
 



23. Corrected a problem with M25 (Return tool to start) in graphics 
only mode.  If an X or Z-axis move was very small, then it would 
not update the lathe counter(s) correctly. 

 
24. Added checkbox "Prompt for Return to Start?" on the Machine 

Parameters screen.  The default value is checked.  If this 
checkbox is unchecked then TurnMaster will no longer ask the 
user "Return Tool to Start ?" when running a program. 

 
 



 
 Date: May 29, 2013 
 Subject: Enhancements resulting in revision 5.2.155 
 By: Jeff Kidd 
 
 

1. Corrected a problem on the Wizards | Threading screen.  The 
generated G01 codes on the Sharp Edge Breaker Pass (if selected) 
now correctly accounts for 0.050" clearance assumed in the 
generated G33 (Threading) command. 

 
2. The M06 - Tool Change message box is now larger and easier to 

read. 
 
3. Added a Single-Step checkbox to the M06 - Tool Change message 

box.  If checked, TurnMaster will enter Single-Step mode and 
stop before the execution of each line. 

 
4. Corrected a problem with G83 and G87 Multi-Depth Cycles, not 

working correctly when a G92 command was active. 
 
5. Added read-only variables (TM_TOOLRADIUS), (TM_TOOLXOFFSET), and 

(TM_TOOLZOFFSET) which will return the radius and offsets of the 
currently selected tool, respectively.  See Appendix F in the 
user's manual for more information. 

 
6. Improved the display screen for math syntax errors found in the 

G-code program. 
 
7. Added Plunge Angle capability to the Threading Wizard.  This 

option will generate a subroutine which will do a multi-depth 
thread, one level at a time with a variable Plunge Angle between 
25 and 35 degrees. 

 
8. Added National Taper Pipe (NPT) values to the threading table. 
 
9. Corrected the problem where the main display redraws after 

switching to the full-screen editor when any change to the 
program was made. 

 
10. Added <Cancel> button on the "Save System Parameters?" screen.  

If pressed, no action will be taken, and TurnMaster will not 
terminate. 

 
11. Corrected a problem with the MRU (Most Recently Used) file list.  

Previously, if a file couldn't be found it was removed from the 
MRU.  Now all MRU files are retained regardless of whether the 
file still exists. 

 
 
 



 
 Date: December 6, 2012 
 Subject: Enhancements resulting in revision 5.2.143 
 By: Jeff Kidd 
 
 
1. Corrected a problem with G83 and G87 commands where the Z- 

parameter was used as an absolute position instead of actual 
depth.  This was an isolated issue only on two recent releases 
issued in 2011.  All prior versions and this release correctly 
treat the Z parameter as actual depth into the material with 
the standard .050” clearance. 

 
2. Only write .TIM file when executing a G-Code program while in 

Machine (or Both) mode.  Added the information for total 
running time, and if a program terminated abnormally. 

 
3. The "z origin" value in the setup file (.tps) is now being 

saved as "Left" or "Right" instead of 1 or -1.  Setup files 
using the old format continue to be supported. 

 
4. Added entries to the Threads.MDB database to include 

additional standard threading sizes.  With this release the 
Threading wizard is able to generate many more threads with a 
quick selection instead of entering custom value. 

 
5. If a program is cancelled vie the Key Pause screen, then 

TurnMaster will restore the CNC display textbox to the line # 
that was being executed when the program was paused. 

 
6. When in Metric mode, the F-parameter (Feedrate) and the D-

parameter (Downfeed speed on multidepth canned cycle commands) 
are now interpreted as mm/Min.  Previously these parameters 
were interpreted as (10 * Inches)/Min, regardless of 
Inches/Metric mode.  No changes are made to the Inch mode. 

 



 
Date: September 13, 2012 
Subject: Enhancements resulting in revision 5.2.137 
By: Jeff Kidd 
 
 

1. Added a "No pause on comment lines when stepping." checkbox on 
the KeyPause screen.  The default value for this checkbox is 
checked. 

 
2. If nothing changed on the Options | Material Size screen, then 

don't redraw main screen. 
 
3. Corrected a problem on the MN400 Jog Screen.  When using the RS-

232 interface instead of USB, pressing a key on keyboard was not 
stopping the current jog in progress. 

 
4. After completion of a program, write out a summary of tools used 

and respective machining times for each tool.  The file will be 
named the same as the CNC program but with a .TIM extension.  
This appends new information to the existing file. 

 
5. Save "Jog Distances" on the MN400 Jog Screen with up to 5 

digits.  Previously, these values were rounded to 4 digits when 
exiting and restoring the screen. 

 
6. Allow distances equivalent to 1-step for the "Jog Key 

Resolution" values in the Machine Parameters screen, Jog Keys 
tab.  Previously, the smallest value allowed was the distance 
equivalent of 2-steps. 

 
7. Corrected a problem with G33 Threading Cycle.  If the thread 

started at other than Z = 0, the spindle would not decelerate at 
the correct point in the move. 

 
8. Corrected a problem with the graphics on a G33 Threading Cycle 

when a G92 Set Tool Start Position has been used.  The threading 
graphic did not mirror correctly on the top and bottom of the X-
axis. 

 
9. Corrected a problem with the G04 Dwell command, which was not 

allowing a user keystroke to pause the program. 
 



 
Date: June 19, 2012 
Subject: Enhancements resulting in revision 5.2.130 
By: Jeff Kidd 
 
 

1. Added a delay value in the Advanced tab of the Machine 
Parameters screen.  The default value is 0.003 seconds and is 
needed to prevent fast PC’s from causing a communication error 
with the MN400 which caused a hang up. 

 
 
2. Corrected a problem with M25 (Return to Home Position) in 

graphics mode.  Under certain conditions, the graphical tool's 
X-position would display incorrectly. 

 
 
3. Improved the labeling of the visual grid.  With some material 

sizes, some Z-grid labels were missing as they attempted to 
display at the top and bottom edges of the screen. 

 
 
4.  Previously, the spindle stopped anytime a tool change is 

commanded.  This has been corrected such that, during a tool 
change, it stops the Spindle and Coolant only if the Tool Change 
Pause checkbox is checked.  This bug was present in Ver 5.2.125 
released in Spring 2012. 

 
 
 
 



 

Date: May 10, 2012 
Subject: Enhancements resulting in revision 5.2.125 
By: Jeff Kidd 
 
 

1. In the Machine Parameters screen, added the ability Save As a 
filename in a different directory.  Previously, Save As only 
worked on the current working directory   

 
 
2. Corrected a problem in the Tool Chest screen.  If a different 

tool was selected while in Machine mode and the MN400 Controller 
was turned off, a Retry / Continue Offline message box appeared.  
Selecting Retry was causing an "Error 5" message and TurnMaster 
would terminate. 

 
 
3. Allow "Single-Step with Canned Cycles?" checkbox on the Program 

Pause screen to work in Graphics Only mode. 
 
 
4. On the MN400 Jog Screen, if using an Axis-3 Stepper Motor, , 

pressing the Advance Tool Turret button now turns on Output #8.  
This is now consistent with the tool change command as described   
in Item #8 of the release notes for Version 5.2.114. 

 
 
5. Added a checkbox "Write values to part program?" to the Options 

| Tool Start Positions screen.  If checked, the X and z start 
positions will be written, as metacommands, to the part program. 

 
 
6. Added ability to modify the order of axis movement during an M25 

command.  The default order for a standard tool is X then Z.  If 
the current tool is a rotated tool, the default order is Z then 
X.   

 
 For example: M25 XZ     \-- Move X then Z-axes. 
    M25 z  \-- Always move Z-axis first. 
    M25  \-- Use default order of axes. 
 
 
7. Added read-only access to Tool Radii and Offsets. Use the system 

variable names TM_TOOLRADIUSx, TM_TOOLXOFFSETx, and 
TM_TOOLZOFFSETx, where x is a valid tool number from 1 to 99.   
See Appendix F in the User's Manual for a complete list of 
system variables. 

 



 

8. Added the ability to view values of user-defined or system 
variables (variables within parenthesis "( )") or evaluated 
formulas (mathematical formulas between bracket pairs "[ ]") via 
the comment line of an M00 command. 

 
 For example: G28  (NextYear) = [YEAR[0] + 1] /Set 

Value 
    M00  / Next Year = (NextYear) 

 
 Or simply: 
    M00  / Next Year = [YEAR[0] + 1] 
 
 Would display the M00 Message Box with the message: 

 
    "Next Year = 2013" 
 
 

9. Added a new M01 command.  M01 is identical to M00 with the 
exception that all Coolant and Spindle outputs (Outputs 1, 2, 
and 5), and any VFD Spindle Controllers (Teco 7300, or 
Fluxmaster 100) will be turned off while the message box is 
displayed, and restored to their original state upon completion 
of the command. 

 



 

Date: February 28, 2012 
Subject: Enhancements resulting in revision 5.2.114 
By: Jeff Kidd 
 
 

1. If a Tool Changer (Axis 3 Stepper or AC Motor) is selected in 
the Machine Parameters screen, the Tool Change Pause checkbox 
will be unchecked and disabled.   

 
2. Removed the "Serial Spindle" checkbox on the Machine Parameters 

screen, Serial Spindle tab.  Now, the user simply selects among 
three radio buttons (None, Teco 7300, and FM100). 

 
3. When Feed Hold mode is turned off, and the safety shield is 

opened, stop rotation of the spindle in addition to stopping X, 
and Z movement.  The spindle is restarted if the <Continue> 
button is pressed on the Pause screen. 

 
4. Modified the G81 command using the i (depth per pass X-axis).  

Previously, the i-parameter was used to determine the number of 
passes, and the depth would be divided equally between passes.  
Now the actual depth specified in the i-parameter is used, with 
any leftover amount cut during the last pass. 

 
5. Modified the G82 command, as specified above for the G81 

command.  In addition, the i-parameter was changed to k, to 
better represent that movement is along the z-axis. 

 
6. Corrected a problem with Control | Reposition From Limits 

function.  If the current tool was not Tool #1 and had different 
X and/or Z offsets from Tool #1, then the tool would not return 
to the home position correctly. 

 
7. Corrected a problem that occurred when a G-Code program is 

running past midnight.  Under certain rare conditions, 
TurnMaster would not handle the date change correctly and hang. 

 
8. During a Tool Change, if using an Axis-3 Stepper Motor, the 

software now turns on Output #8.  With the proper add on 
circuit, this disables the FeedRate Override on the MN400 during 
tool changes and provides very reliable high speed tool changes. 

 
9. Added read-only access to most system variables in the Machine 

Parameters screen.  See the new Appendix F in the User's Manual 
for a complete list of variables.  

 
 
 
 
 
 



 

Date: November 30, 2011 
Subject: Enhancements resulting in revision 5.2.108 
By: Jeff Kidd 
 
 

1. After jogging the tool via the MN400 Jog Screen, if in Both 
(Machine and Graphics) mode, the graphical tool image position 
was not being updated.   

 
2. When issuing a Return to Start command (via the menu, or M25), 

if the X-axis is greater than the X-home position, move the Z-
axis first, then the X-axis.  Otherwise, move the X-axis first.  
Previously the X-axis was always moved first regardless of the 
current tool position. 

 
3. Corrected a problem on the Spindle Control screen used with the 

FluxMaster 100 or Teco 7300 spindle controller.  If a spindle 
RPM greater than 32,767 was entered, an error occurred and 
TurnMaster would shut down.  That error now is handled with an 
error message. 

 
4. Added a "Single-Step with Canned Cycles?" checkbox on the 

Program Pause screen.  If checked, there will be a pause between 
individual moves within each canned cycle. 

 
5. Modified the Control | Reposition From Limits and Control | 

Reprogram Limit Censors functions such that after homing to the 
limits, the Z-axis returns to home followed by the X-axis.  
Previously, the X-axis returned to its home position first. 

 
6. Corrected a problem with the baud rate when using an MN400 with 

a serial connection.  Baud rates other than 9600 were being 
ignored in the Machine Parameters screen. 

 



 
Date: October 14, 2011 
Subject: Enhancements resulting in revision 5.2.103 
By: Jeff Kidd 
 
 

1. In the Tool Chest screen the "Side Tool" (i.e. Boring Bar, 
Drill, etc.) checkbox has been removed. Now, the dimensions of 
newly selected image file are automatically detected and the 
orientation is set appropriately.   

 
2. If using a "Side Tool" (i.e. Boring Bar, Drill, etc.), the M25 

(Return Tool To Start) will retract the Z-axis first, followed 
by the X-axis.  For conventional tools, the existing 
functionality, of retracting the X-axis first, is retained. 

 
3. Added a warning message if user tries to change the X and/or Z 

tool offsets in the Tool Chest screen. 
 
4. On the MN400 Jog Screen, improved the error message to give more 

information, when trying to touch off a tool other than Tool #1. 
 
5. On the MN400 Jog Screen, if any X and/or Z tool offsets were 

changed, added a message box asking if the user wants to write 
these values as Meta-Commands to the current part program. 

 
6. In Windows Explorer, a new feature has been added, such that if 

the user double-clicks on a .CNC file, and TurnMaster is already 
loaded, the existing instance of TurnMaster will try to load the 
selected file.  If TurnMaster is busy, it will not try to load 
the selected file. 

 
 Note: The TurnMaster application must be associated with the 

.CNC    extension via Windows Explorer for this to work. 
 
7. Corrected a problem when the first line of a program contained a 

MetaCommand containing a comma ",".  In this case the comma was 
not being parsed correctly. 



 
Date: August 31, 2011 
Subject: Enhancements resulting in revision 5.2.100 
By: Jeff Kidd 
 

 
1. Added an optional D (Dwell) parameter to the G33 Canned Threading 

Cycle command.  If a D-parameter is seen, TurnMaster will dwell for 
the specified number of seconds after each threading pass. 

 
2. Added menu options Edit | Enlarge Font and Edit | Reduce Font.  The 

default font size is 8.25 pt and can be enlarged up to 16 pt. 
 
3. Reduced the RPM lower limit for the G96 (Constant Surface Speed) 

command from 60 RPM to 5 RPM.  This is the lowest RPM that will be 
commanded by TurnMaster during Constant Surface Speed operation. 

 
4. Improved the error handling on the Teco 7300 spindle controller.   

If a speed greater than the maximum allowable speed is issued, 
TurnMaster was waiting unnecessarily before executing the next     
G-Code command. 

 
5. Improved the operation of G96 (Constant Surface Speed).  The minimum 

speed now allowed during CSS operations is now 5 RPM (previously it 
was 60 RPM).  Also, TurnMaster now initializes the spindle speed as 
soon as a G96 is seen, instead of waiting for the first X-axis move.  
The RPM display, during CSS operations, has also been improved. 

 
6. Added "Reverse Lock Steps" input field on Machine Parameters screen, 

Advanced tab.  This field is used for tool changers attached to an 
axis-3 stepper motor, with reverse locking. 

 
7. Added 2 buttons, "Advance Tool Turret" and "Tool Turret Rev Lock", 

on the MN400 Jog Screen.  These buttons are only used with axis-3 
stepper tool changers. 

 
8. Added a new frame "Axis-3 Tool Turret" and 2 buttons "Advance" and 

"Rev Lock".  These buttons are only used with axis-3 stepper tool 
changers. 

 
9. When an M00 command is processed, display the comment (if any) in 

the message box.  This allows the user to customize the message. 
 
10. Corrected a problem processing the {UNITS}: metacode.  If the 

specified unit (Inches or Millimeters) changed, not all the 
conversions were being done. 

 
11. Convert the "Jog Distances" when converting units.  Previously, 

these values were not being converted. 
 



12. Disabled line autowrap from the editor Display.  Previously, a line 
wrapped, the displayed line # would not match the actual line # when 
the program executed.  

 
13. Added part origin parameters to Options | Material Size screen.  

These values may now be independently attached to the current 
program or the default setup file, or both. 

 
14. Added "Used" checkbox for each tool, and a button to "Write Tool 

Meta-Commands to Program" to the Tool Chest screen.  Clicking this 
button will write a "{TOOL}:" meta-command, in the current G-Code 
program, for each tool whose "Used" checkbox is checked. 

 
15. Added a message box, reporting estimated machining time, at the end 

of a program run in Graphics mode.   
 
16. If the user tries to display the Help file and Adobe Reader is not 

found, then display a reminder to the user to install Adobe Reader. 



 
Date: June 2, 2011 
Subject: Enhancements resulting in revision 5.2.75 
By: Jeff Kidd 
 
 

1. The file I/O now retains the current directory after saving or 
loading a file in various ways.  Previously if TurnMaster Pro was 
loaded by dragging a file or double clicking a file, then the 
source directory was not remembered. 

 
2. Display thumbnails on the left of the PDF Help File when 

initially displayed.  All other PDF options are retained from the 
previous viewing of the help file. 

 
3. Corrected a problem in Millimeter mode, when some arcs were 

reporting an incorrect I and/or K parameters.  The test for error 
was adjusted to take into account the millimeter vs inch mode and 
to use a proper tolerance. 

 
4. Absolute Programming Mode (G90) is now the default for TurnMaster 

if no G90 or G91 command is present.  Previously Incremental Mode 
(G91) was the default.  If a G90 or G91 is issued at the start of 
the program (recommended), then the program will work as it 
previously did. 

 
5. Multiple Arc Programming Mode (G75) is now the default mode for 

TurnMaster.  Previously Single Arc Programming Mode (G74) was the 
default mode.  If running an older CNC program a G74 may be added 
at the beginning to work as did previously. 

 
6. Corrected a problem where the screen was unnecessarily being 

redrawn when running a CNC program that contained Meta Commands. 
 
7. For consistency between programs, Edit | Undo is now the first 

selection listed under the Edit menu. 
 
8. Improved the File | DXF Import function as follows: 
 

  - Coordinates are written with up to 5 decimal places. 
  - Extra comments are written to the output file. 
 
9. The default Feed Rate on the MN400 Jog Screen is changed from 10 

ipm to 5 ipm. 
 

10. Corrected a problem when selecting Top Side Tool Image Location 
in the Machine Parameters screen.  The tool was not always 
positioned properly. 

 
 

 
 



 
Date: March 22, 2011 
Subject: Enhancements resulting in revision 5.2.67 
By: Jeff Kidd 
 
 

1. Do not process the Pause Program Execution functions (Key_Press 
event on the Main Form) while the Tool Changer is active. 

 
2. Corrected a problem when drawing the yellow material on the 

screen.  Sometimes the yellow color would "spill over" the edge 
of the material by an amount equal to the radius of the last 
tool used. 

 
3. Enhanced the M03 and M04 commands when using the FluxMaster 

FM100 or Teco 7300 serial spindle controller.  The S-parameter 
(spindle speed) can now have a negative value.  This will have 
the effect of not waiting for the spindle to spool up before 
continuing to the next G-code statement. 

 
4. Added G64 - Turn ON Continuous Contouring and G60 - Turn OFF 

Continuous Contouring.  The checkbox on the Machine Parameters 
screen will be the initial setting of Continuous Contouring each 
time a program starts up. 

 
5. Corrected a problem when certain math operations resulting in a 

large number of decimal places.  A dubious error message "Wrong 
sign or bracked placement." was being generated. 

 
6. Improved the drawing of the grid.  When the number of units was 

very large, too many grid lines were being drawn. 
 
7. When jogging and the system is in Metric mode, the large 

distance warning for fixed moves was set at 10mm.  It is now set 
at 254mm or the equivalent of 10 inches. 

 
8. Corrected a problem when opening a .CNC file from the Windows 

File Folder, TurnMaster Pro would not always auto-load the file 
selected. 

 
9. Changed the acceptable input range of the "Taper Angle" field on 

the Threading Wizard screen to -45 to 45 degrees.  Previously 
the range was 0 to 90 degrees. 



 
Date: December 16, 2010 
Subject: Enhancements resulting in revision 5.0.52 
By: Jeff Kidd 
 
 

1. Added an option in the Machine Parameters, Advanced Tab to 
allow  curves to be approximated by multiple chords. 

 
2. Added # of Chords per Circle to the Advanced tab of the 

Machine Parameters screen.  Previously, TurnMaster always used 
360 chords per circle when using chords. 

 
3. Added M94 - Issue Literal Command to MN400 Controller 

functionality.  Using this M-command, you can send a native 
MN400 command to the controller unedited.  The command can be 
surrounded by double quotes, but this is not required.  This 
command will be ignored if not in Machine mode or a different 
controller is used. 

 
     Examples:  M94 m1000,500 
    m94 "m1000,500" 
    m94 m1000,500 /MN400 native move 
 
   Any of the preceding commands will issue a native command to 

the 
   MN400 Controller, moving the X-axis 1000 steps and the Z-axis  
   500 steps. 

 
4. Corrected a problem in the Tool Chest screen.  Under certain 

conditions, the Side Tool checkbox was not being saved 
correctly. 

 
5. Added G83 and G87 Canned Drilling Cycles functionality.  See 

the documentation for a detailed explanation of these 
functions. 

 
6. Corrected a problem in the  G33 (threading) function.  

Previously there may have been a small delay at the end of the 
threading cycle before retracting the tool.  This would cause 
an unwanted groove at the end of the thread. 

 
7. Corrected the tab order on the Material Size screen. 

 
8. Corrected a problem with certain arcs in the Taper & Arc 

Roughing screen.  The Z-values of the roughing cuts were 
sometimes invalid. 

 
9. Corrected a problem with an unnamed and unsaved program. 

Sometimes changes were not saved correctly when pressing <F5> 
Auto Run. 

 



 
 
 

10. Added Extend Rough Cuts to: (Z-Axis) field in the Taper & Arc 
Roughing screen.  When backing out of a taper or arc rough 
cut, continue to this new Z-coordinate.  Previously, the Z-
axis would back out only to the starting Z-position of the 
taper or arc. 

 
11. Do not report an error when closing TurnMaster if the MN400 

controller was turned off before exiting. 
 

12. Corrected a problem saving the parameter Origin Left. 
 

13. When closing the application using the X in the upper left 
corner of the main screen, perform the same end-of-program 
checks as when closing using the File | Exit menu selection. 

 
14. After running diagnostics, the Diagnostic Results screen 

defaults to No, when asking whether to save the results. 
 

15. On the Diagnostics Results screen, display N/A in the results 
summary for any axes not tested. 

 
16. Disable entry fields for Unramped Distance and Ramped Distance 

for any axes not selected. 
 

17. Added Electric Pulse Tool Turret in the Machine Parameters 
screen, Advanced tab. 

 
18. Corrected a problem with the Math Evaluator.  If several very 

small numbers were added (subtracted) there was a possibility 
of an error accumulation due to rounding. 

 
19. Graphically draw internal threading using thin dashed lines.  

Previously, only external tapers were drawn in graphics mode. 
 

20. Corrected a problem when executing a G02 or G03 (Circular Cut) 
after an M97 (Wait for Input).  If you used the R (Radius) 
parameter you would sometimes get an error stating the arc 
endpoints or center points were not correct. 

 
21. Don't redraw the CNC Program Window after saving the file. 

This was resulting in the loss of the cursor position within 
the program. 

 
 
 



Date: April 20, 2010 
Subject: Enhancements resulting in revision 5.0.31 
By: Jeff Kidd 
 
 

1. Added the option for arc roughing on the Taper wizard and 
renamed it to Taper & Arc Roughing wizard. 

 
2. Corrected computation of Start of Taper (X-Axis) and End of 

Taper (X-Axis) on the Taper & Arc Roughing wizard. 
 

3. Improved the looks of the displayed arrowheads on the Taper & 
Arc Roughing wizard. 

 
4. The Angle of Taper is now displayed in the range -90º to 90º 

on the Taper & Arc Roughing wizard. 
 

5. Improve the MN400 Jog Screen to reestablish the correct jog 
speed after reconnecting to the controller. 

 
6. Corrected a problem with File | Save.  On a newly created 

file, after the initial save, subsequent saves without an 
intermediate Open would not save the changes. 

 
7. Display the currently active tool instead of Tool #1 when 

initially displaying the Tool Chest screen. 
 

8. Do not redraw the screen when exiting the Tool Chest screen. 
 

9. Corrected a problem when the Run From 1st Line menu item is not 
checked and a VFD spindle controller is installed.  If the 
user selected <Cancel>, when asked to enter the line # to 
start from, the Automatic Spindle warning message would 
display erroneously. 

 
10. Added a Always Run From First Line button on the Run From Line 

# screen.  When pressed the Run From 1st Line menu item will be 
checked and all subsequent runs will be from the first line. 

 
11. On the Find/Replace text edit screen, the Replace Next button 

was changed to Replace This.  Pressing this button now changes 
the currently highlighted text to the replacement text. 

 
12. Display a message reminding the user to restart TurnMaster if 

the backlash values have changed in the Machine Parameters 
screen. 

 
13. Clear any old filenames when performing File | New.  

Previously the last open filename was retained if a subsequent 
File | Open was performed. 

 



14. If no changes were made to the Serial Spindle Control 
parameters, then don't attempt to reinitialize spindle 
controller when exiting the Machine Parameters screen. 

 
15. Allow user option to skip retrying of the connection to the 

Teco 7300 Serial Spindle Controller for the current session. 
 

16. Improved the accuracy of ARC endpoint calculation on the File 
| Import .DXF function.   

 
17. Changed product name to TurnMaster™ 2010. 

 
18. Added up to 9 most recently used (MRU) files on the File menu. 

 
19. Improved the performance of threading.  In previous versions, 

TurnMaster would delay several seconds between threading 
passes. 

 
20. Remove focus from the Spindle and Coolant buttons, in the 

MN400 Jog Screen, after they are pressed.  This prevents an 
accidental pressing of the button during motor motion if the 
<Space Bar> is pressed to stop motion. 

 
21. Display the updated the position counters after a Tool Change 

if in machine mode.  Previously, the updated position values 
were not displayed until a subsequent move occurred. 

 
22. When opening an existing file, the Line # on the status bar is 

now set to 1 instead of 0. 
 

23. Corrected a problem when selecting File | Open.  An erroneous 
dashed rectangle was sometimes being drawn. 

 
24. Corrected a problem with the Math Evaluator.  If a number 

immediately following an open bracket "[" was entered without 
any decimals to the left of the decimal point (ie .123) then 
an error occurred.  For example the line "G01 x[.95+(LastX)]" 
was reporting an error, but the equivalent line "G01 
x[0.95+(LastX)]" worked correctly. 

 
25. Added menu option Edit | Undo.  This menu selection is only 

available in full screen edit mode, and reproduces the 
functionality of the <Ctrl> Z hotkey. 

 
26. Corrected a problem when saving a newly created file.  

Occasionally, the File | Save menu selection would ask for a 
filename even though the file has already been saved. 

 
 
 
 
 



 
Date: October 14, 2009 
Subject: Enhancements resulting in revision 5.0.8 
By: Jeff Kidd 
 
 

1. Corrected "Error 6: Overflow" when machining arcs if a signal 
was received from Input #8. 

 
2. Modified the Edit | Find/Replace screen to easily toggle 

between Find and Replace modes. 
 

3. The Replace All button on the Edit | Find/Replace now replaces 
all occurrences regardless of the cursor position. 

 
4. Enhance the End of Program message box to include total 

elapsed time, time machining, and time waiting for user input. 
 

5. Corrected a problem on Vista machines.  When opening a new 
file, the display would sometimes redraw unexpectedly with the 
wrong zoom values. 

 
6. Corrected a problem on Vista PCs only.  When opening a new 

.CNC file, the graphics window would unexpectedly zoom-in 
before asking "Restore Graphics ?". 



 
Date: September 23, 2009 
Subject: Enhancements resulting in revision 5.0.6 
By: Jeff Kidd 
 

1. On the Machine Parameters screen, the name of the "Closed 
Loop" tab changed to "Backlash" to better describe entry 
fields. 

 
2. When running a G-code program, changed the color of the 

currently highlighted G-code line (the line currently 
executing).  Previously, the current line was difficult to 
see.  

 
3. Added "Axis 3 Turret Speed" entry to the Machine Parameters, 

Advanced tab.  If an tool turret is installed on axis 3, this 
will be the speed it rotates (steps/sec) when an M06 tool 
change is commanded. 

 
4. Keep track of accumulated partial step errors during Jog, Move 

to Point, and Interactive Commands. 
 

5. On the Tool Change message box, details of the next tool are 
displayed. 

 
6. Corrected a problem in the MN400 Jog Screen.  If the jog speed 

was very slow (< 0.5 inches/min), the screen counters would 
sometimes stop prematurely. 

 
7. Corrected a problem with the Show Last button on the 

Diagnostics form.  All comma (",") characters were being 
interpreted as  carriage return, line feed (<CR><LF>) 
characters. 

 
8. On the Diagnostics screen, display a brief summary of the 

results at the bottom of the scrollable textbox. 
 

9. Added Loop counter to the status display above the CNC code 
window. 

 
10. Added new Toolbar items for Return Tool To Start, and Init As 

Start Position. 



 
Date: April 23, 2009 
Subject: Enhancements resulting in revision 5.0.3 
By: Jeff Kidd 
 

1. Corrected a problem with G92 (Set current program position).  
If multiple G92s were present in a program, the shift values 
would not always be correct. 

 
2. Corrected a problem with Control | Return Tool to Start.  If 

a G92 was used in a G-Code program, the first Return to Start 
issued would not clear out the shift values. 

 
3. Corrected a problem with the MK_Install.EXE program shipped 

on the installation CD, that affected Windows 98 PCs only.  
The program would display, but the buttons did not function. 

 
4. Corrected a problem with G02/G03 arc commands using the R 

(radius) parameter.  Occasionally, a rounding error would 
cause an incorrect error message. 

 
 
 



Date: April 14, 2009 
Subject: Enhancements resulting in revision 5.0.2 
By: Jeff Kidd 
 
1. Corrected a problem with the Keypad/Display on the Teco7300 VFD.  

If the Gear Selection on the Options | Machine Parameters, Serial 
Spindle tab changed, the readout on the Teco7300 would not always 
display correctly.   

 
   Note: The spindle was spinning at the correct RPM.  Only the 
   display was incorrect. 
 
2. Modified the install package to set the MultiCAM directory to be 

Read/Write for all users. 
 
3. Corrected a problem with File | Save As.  Sometimes on the first 

attempt to save the default directory was not set. 
 
5. Added "Sel" (Selected Tool) option buttons to the Tool Chest 

screen.  Clicking this button next to a tool, then pressing 
<Save> or <Accecpt> will have the result equivalent to executing 
a "M06 Tt" CNC command. 

 
6. Set the initial focus on the Machine Parameters Password screen 

to the password entry field. 
 
7. When selecting File | New, TurnMaster no longer displays the   
    message box "System Parameters have changed...". 
 
8. If the "Skip checking for a controller connection for this 

session." checkbox was selected on the MN400 Communication 
screen, then no longer check for a Serial Spindle connection 
either. 

 
9. Corrected a problem that occurs when using a Serial Spindle 

Controller.  If the user selected "Cancel" to the "Automatic 
Spindle Controller is active... Would you like to continue?" 
message, then the CNC Edit Window would revert to the last saved 
copy the CNC file, losing any changes since the last save. 

 
10. Corrected a problem in the MN400 Jog Screen.  If the radio button 

for a specific Jog Distance was selected and the associated 
distance was blank, the user would receive a "Type Mismatch" error 
and TurnMaster would terminate. 

 
11. Added Coolant On/Off, and Spindle On/Off buttons to the MN400 Jog, 

and the Move to Point screens. 
 
12. If Control | Reprogram Limit Sensors was executed, TurnMaster will 

remind the user to "Save Parameters?" before exiting. 
 



13. Corrected a problem after running a program in Graphics mode, 
then zooming an area using the mouse.  The rectangle box 
drawn was sometimes a thick solid line instead of a thin 
dashed line. 

 
14. TurnMaster no longer redraws the grid after running a program 

in Graphics mode.  Previously, this could obscure tool path 
lines  just drawn. 

 
15. In the File | Open dialog box, added All Files (*.*) as an 

allowable file type in addition to CNC Files (*.CNC). 
 
16. Added a checkbox to "Save values to setup file." on the 

Options | Material Size screen to allow the new values to be 
immediately written to the setup file. 

 
17. If the Material Size changed, but the values were not saved, 

then remind the user that "System Parameters have changed." 
before exiting TurnMaster. 

 
18. Added menu option View | Redraw Screen (<Ctrl> D) which will 

clear a previous graphical run, but retain the viewport size 
and location. 

 
 Note:  The View | Restore Screen (<Ctrl> R) menu option 
   still clears the graphics and restores the location 
   and viewport size to their default values. 
 
19. Improved the function of Zoom In and Zoom Out buttons.  

Zooming now maintains the center point of the current view. 
 
20. The Pan button now toggles Pan mode On and Off.  Before this 

release, pressing the Pan button turned Pan Mode On, 
regardless of its current state.  The only way to exit Pan 
mode, was to press one of the three Zoom buttons. 

 
21. Added a <Cancel> button to the M00 Temporary Stop message 

box.  Now, the user has the opportunity to press <Cancel> to 
terminate the part program. 

 
22. Added a warning message on the MN400 Jog Screen.  If the user 

enters a measured move of at least 10, with no decimal point, 
then warn the user of a potential entry error. 

 
23. Corrected a problem when double-clicking on the full screen 

edit window would sometimes re-zoom the resulting graphics 
screen. 

 



24. Corrected a problem with the graphics associated with drawing 
a thread.  Occasionally the graphics would draw the thread 
outside of the actual threading area, or draw a stray line 
outside the threading area.   

 
 Note:  This only affected the graphical image on the screen 

and  
    not the actual machining of the thread. 
 
25. Increased the size of the CNC Display window to accommodate 

more lines of the CNC program to be displayed. 
 
26. Added an icon on the top toolbar to toggle the CNC Full-

Screen Edit mode On/Off.  Previously, double-clicking in the 
CNC Edit Window would toggle the Full-Screen mode, but this 
feature has been disabled.  Double-clicking in the CNC Edit 
window now simply highlights the current word. 

 
27. Moved Start Position and Tool Chest menu items from the Tools 

Menu to the Options menu.  Renamed the Tools Menu to Wizards 
Menu.  These changes should help to avoid confusion between 
the old Tools Menu and the Tool Chest. 

 
28. Corrected a problem after saving a file, the cursor position 

in the CNC Display textbox would move to the beginning of the 
file.  Now the cursor will retain its position after the save 
is completed. 

 
29. Added support for the R (Radius) Parameter in the G02/G03 

commands.  If the I and K parameters are not specified and 
the R parameter is specified, TurnMaster computes up to 2 
possible arc center points and draws the shortest of the 2 
possible arcs.  If the R parameter is negative the longer of 
the 2 possible arcs is drawn. 

 
30. Corrected a problem introduced in Version 4.3.74 where the 

Continuous Contouring and Track External Control Panel 
options, in the Machine Parameters screen, were being 
inadvertently cleared out. 

 
31. Added two checkable menu selections under the View menu.  

Thin Path Lines and Arrows on Path Lines will change the way 
the graphics displays in order to allow the user to see more 
detail in the cutting of the part. 

 
32. Corrected a problem when running a program in Graphics mode, 

the Line # displayed was not always updating correctly. 
 
33. Added a reminder message to save system parameters after 

executing Control | Reprogram from Limit Sensors. 
 



34. Corrected a problem when touching off tools from the MN400 
Jog Screen.  If some tool other than Tool #1 was active, the 
touch-off values saved by TurnMaster would be relative to 
that tool instead of Tool #1.  TurnMaster will now prompt the 
user to change the active tool and touching off Tool #1 
before touching off any other tool. 

 
35. Added a one-time "Terms & Conditions" notice. 

 
36. Display an "Controller Offline" message if user tries to 

perform a function that requires connection to the 
controller, and it is Offline. 

 
37. Previously Control | Reposition from Limits, Control | 

Reprogram Limit Sensors and Control | Home to Limits.  If the 
user aborted a move in progress, the CNC Edit Window would 
revert to the last saved copy the CNC file, losing any 
changes since the last save. This has been corrected. 

 
38. Improved the performance of the Teco7300 VFD when changing 

directions. Previously, there was an extra 10 second delay 
when changing directions from M3 to M4 without using M5 to 
stop the spindle. 

 
39. Corrected a problem when opening a .CNC program while in Both 

(Graphics and Machine) mode.  TurnMaster would receive a      
"Run Time Error 5" and shut down. 

 
40. Disable the CNC Edit Window while a program is running.  This 

prevents the user from changing the .CNC program during 
execution. 

 
41. If the user cancels the "Program Pause" screen, it will now 

behave as if the "Stop Program" button was pressed.   
 
 
 
 



 
Date: November 26, 2008 
Subject: Enhancements resulting in revision 4.3.74 
By: Jeff Kidd 
 
 

1. Corrected a problem with "Get Settings" button on the Machine 
Parameters page, Serial Spindle tab.  Occasionally, the wrong 
serial port was being tested. 

 
2. Improved the reliability of the Serial Spindle "Get Settings" 

button in Machine Parameters. 
 

3. Improved the Global Error Message to be more descriptive of 
the error and calling routine. 

 
4. Improved both the G-Code Parser's and Math Evaluator's syntax 

error messages to include the line # and source text of the 
   G-code line containing the error. 

 
5. Improved the handling of MN400 Communications Errors using the 

USB port.  TurnMaster will now try to diagnose the problem and 
reconnect if possible. 

 
6. Corrected a problem after an M66 command while in Relative 

Programming Mode.  The next computed destination was not 
always correct. 

 
 
 
Date: September 18 2008 
Subject: Enhancements resulting in revision 4.3.72 
By: Jeff Kidd 

 
1. The threshold for displaying the "Tool not at start." message 

at the beginning of a program was changed from 0.00005 inch to 
the distance each axis moves per motor step. 

 
2. The File|Open and File|Close menu selections now query the 

user to save the current CNC program if it was not saved. 
 

3. TurnMaster will no longer automatically save the current CNC 
program file when switching from the large CNC Edit Mode to 
the normal view mode. 

 
4. Modified the Diagnostics to use a safe speed when moving away 

from the limit switch.  This assures adequate distance for the 
experimental high-speed move back to the limit switch. 

 
 
 



Date: July 17 2008 
Subject: Enhancements resulting in revision 4.3.71 
By: Jeff Kidd 

 
1. If running TurnMaster on a Laptop PC, don't automatically 

turn NumLock on when entering the MN400 Jog screen.   
 
 Previously, NumLock was turned on when entering the MN400 Jog 
 screen and restored to it's previous state upon exiting.  Now  
 this only happens if the PC is a Desktop PC. 
 
2. For backward compatibility the * (multiply) operator is now 

supported with or without being surrounded by square 
brackets. 

 
3. Under the Tools | Threading function, TurnMaster now uses the 

Unified Standard (UN) depth ratio for internal threading and 
the Unified Standard - Rounded Crests (UNR) depth ratio for 
external threading, respectively, from the Machinery's 
Handbook 27, p. 1734.  Previously, the Sharp V-Thread ratio 
was being used for both internal and external threading. 

 
4. Changed the Measured Move values in the MN400 Jog screen to 

be user definable. 
 
 
 
Date: May 19, 2008 
Subject: Enhancements resulting in revision 4.3.69 
By: Jeff Kidd 
 

 
1. Corrected a problem in the large editor window, if File|Save 

was selected with an unnamed file, TurnMaster would not ask 
for a "Save As" filename. 

  
2. Corrected a problem in the File|Save As window.  If <Esc> was 

pressed an error occurred. 
 

3. Improved the drawing of the last move in Graphics mode.  
Occasionally, when starting a new program, TurnMaster would 
redraw the last move from the previous program execution. 

 
4. TurnMaster no longer displays the "End of Program" message if 

the part program was run in graphics mode only. 
 

5. Corrected a problem in the G25 command.  If an L-parameter (# 
of Loops) was specified using a variable, then the subroutine 
would only execute once.  For example if (INCVAR) was set to 
the value 5, then the command G25 #SUB1 L(INCVAR) would call 
SUB1 5 times. 



 
6. Corrected a problem in the G01 command.  If the move was at a 

very slow speed, TurnMaster would sometimes hang up waiting 
for the move to complete. 

 
7. Modified the Tool Chest form to display tool specifications in 

a table format. 
 

8. Corrected a problem on the MN400 Jog Screen, where pressing 
the  X or Z keys did not always update the respective counter 
to 0 on the first attempt. 

 
9. Updated the "Speeds & Feeds" process under the Tools menu to 

better support the wide variety of tools and materials. 
 

10. Added a Status message indicating the Pass # in progress for 
Canned Cycle commands (eg. G33, G81, and G82). 

 
11. Corrected a problem when the Z-Axis labels were not always 

visible after a screen pan. 
 
 
 
Date: April 7, 2008 
Subject: Enhancements resulting in revision 4.3.65 
By: Jeff Kidd 
 

 
1. Corrected a problem in the Diagnostics.  If the initial 

unramped move failed on a particular axis, the max unramped 
and max ramped speeds for that axis would sometimes be 
incorrectly reported. 

  
2. Corrected a problem in the parser if a <Tab> character was 

seen in the G-code program, the parser incorrectly reported an 
error. 

 
3. Corrected a problem where if the <Esc> key was pressed while 

in the "File Open" dialog box, an error would occur. 
 

4. The G04 (Dwell) command uses the Status Bar to count down the 
seconds remaining, but does not restore the Status Bar after 
completing.  This has been corrected. 

 
5. On the KeyPause form, the <Step> button is now the default.  

Previously, the <Continue> button was the default. 
 

6. The full Revision # is now displayed at the top of the main 
form.  For example "TurnMaster Pro 4.3.65" instead of 
"TurnMaster Pro 4.3". 

 



7. Corrected a problem when in Step mode, after a program 
completed, the top bar menu items sometimes remained disabled. 

 
Date: March 04, 2008 
Subject: Enhancements resulting in revision 4.3.64 
By: Jeff Kidd 
 
 

1. Allow variables and formulas in the “S” (Spindle Speed) 
parameter of the M03 and M04 commands.  For example: 

 
G28 (NormalSpeed) = 100 /-- Set normal Spindle Speed 

  M03 S(NormalSpeed)  /-- Start CW.  Speed = 100 
RPM 
  M04 S[(NormalSpeed)*2] /-- Start CCW.  Speed = 200 
RPM 
 
2. Corrected a problem with M06 (Tool Change), and G04 (Dwell) 

when used with Continuous Contouring.  Previously, the M06 or 
G04 did not clear the pending machine moves before executing 
the Tool Change or Dwell. 

 
3. Added an informational message when converting a DXF file if 

there are any unsupported drawing entities present.  Only 
LINE, POLYLINE, ARC, and CIRCLE entities are supported.  All 
other more complex entities should be converted to lines and 
arcs before exporting to a DXF file. 

 
 Note:  In CorelDRAW use the Arrange | Ungroup All function to 
    separate any lines and arcs into individual entities.   
    Also use the Arrange | Convert to Curves function to  
    convert any text to lines and arcs. 
 
4. Corrected a problem related to the 7300CV VFD.  If the motor 

rated frequency was not 60 Hz, the wrong speed (RPM) was 
displayed on the “Outputs:” caption of the Main Menu. 

 
5. Increased the number of Comm ports number available for the 

MN400 from 4 to 8 to allow the use of USB to Serial converter 
cables.  

 
6. Corrected an “Overflow: Error 6” problem when testing Input #8 

using the “M97 i8” command. 
 

7. Improved the Diagnostics process: 
 

1. added Show Last results button. 
2. added separate distances for Ramped vs Unramped tests. 
3. improved the homing speed during the tests. 

 



8. Corrected several problems on Vista and XP environments using 
the 

  MN400 with USB connection, TurnMaster would: 
 

- occasionally misinterpret the current X position. 
- occasionally start a subsequent move before the current 

move was completed. 
- receive an Overflow Error when executing G02, G03 

commands. 
 
These problems affected Versions 4.3.38 to 4.3.53. 
 

9. Added toggle buttons on the main form for Ouput #7 (Aux 3),  
   and Output #8 (Aux 4). 
 
10. Added the following M codes to work with Outputs #7 and #8 
  (Aux 3, and Aux 4): 
    
   M41 (Aux 3 On) 
   M42 (Aux 3 Off) 
   M43 (Aux 4 On) 
   M44 (Aux 4 Off) 

 
 
Date: December 17, 2007 
Subject: Enhancements resulting in revision 4.3.53 
By: Jeff Kidd 
 

1. Allow the selection of Baud Rate and Communication Settings 
for both the Fluxmaster 100 and the Teco 7300CV spindle 
controllers.  

 
2. Added a button on the “Machine Parameters” form to 

automatically detect communication settings for serial spindle 
controllers.  

 
3. TurnMaster no longer displays communications error messages if 

the software is not unlocked. 
 

4. Num Lock is automatically turned on when entering the MN400 
Jog form in order to allow the arrow keys on the keypad to act 
as jog keys.  Num Lock is restored to its previous state upon 
exiting the MN400 Jog form. 

 
5. Added new command M29 Home to Limits.  The format is: 

 
M29 axis (#varname)  
 

 where axis can be any axis (x or z).  If in absolute  
programming mode then the x or z position is returned in 
#varname.  Otherwise the incremental movement (the distance 
from  



the last position to the limit) is returned in #varname. 
 

6. Corrected a problem where the MN400 would sometimes initialize 
at the wrong startup position at the beginning of program 
start. 

 
7. After pressing the Pan icon, the Mousepointer changes to a 

hand.  Additionally, the “zooming rectangle” is no longer 
drawn when in Pan mode. 

 
8. Corrected a problem for the OptiStep controller on the Move to 

Point screen.  If <Alt> A was used to press the Accept button, 
focus would not return back to the screen. 

 
9. Corrected a problem with the FM100 spindle controller.  

Occasionally an erroneous timeout message would display 
waiting for the spindle speed to arrive at the desired RPM. 

 
 
 
Date: November 06, 2007 
Subject: Enhancements resulting in revision 4.3.41 
By: Jeff Kidd 

 
1. Enhanced the warning message when running a program with a 

serial control spindle. 
 
2. Previously, the “Tested” flags were not being cleared when a 

change was made to the CNC program. This had the effect of not 
displaying an appropriate warning message.  This has been 
corrected. 

 
3. Anti-Virus message will no longer display if Operating System 

is later than Windows 98 and therefore support for OptiStep 
controller not needed. 

 
4. Added logical operators =, >, <, >=, and <= to the math 

evaluator.  If a formula is true, the math evaluator returns -
1, if the formula is false,  0 is returned. 

  
5. The Fluxmaster Spindle controller will now display the correct 

Spindle RPM on the front panel based on the gear selected.  
Previously it displayed the motor RPM.  

 
6. Corrected an “Overflow” error during ramped moves if IN7 or 

IN8 signals were active. 
 
7. Added support for the Teco 7300CV Spindle Controller. 
 
8. Increased number of external outputs from 6 to 8 on the 

outputs tab in machine parameters for the MN400 Controller. 



 
9. Added the ability to lock and unlock the tool changer using 

external outputs 2-8. (previously this worked on output #3) 
 
10. Previously under certain conditions, the Main Menu was not 

being 
      re-enabled after a program was run. This has been corrected. 

 
 



 
Date: Sept 4, 2007 
Subject: Enhancements resulting in revision 4.3.24 
By: Jeff Kidd 
 

1. Check for valid I, K parameters which represent the Center 
Point 
Offsets during circular moves. 
 

2. Clear Continuous Contouring buffer when M00 Pause command 
seen. 

 
3. Corrected a problem with the “Program Paused” screen which 

would sporatically disappear. 
 

4. Corrected a problem with the <Stop> and <Pause> buttons on 
the toolbar being ignored while a program was running. 

 
5. Added TMPFW.CHM Help File for Vista PC users. 

 
 
 
Date: June 7, 2007 
Subject: Enhancements resulting in revision 4.3.16 
By: Jeff Kidd 
 

1. Corrected a problem in M06 (Change Tool).  If no tool was 
selected in the command line, and <Cancel> was pressed on 
the Tool Selection Input Box, an error occurred. 

 
2. Allow for very slow feed rates on MN400 jog.  Limit the 

minimum feed rate to 0.2 IPM on jog screen.  Previously, if 
a very slow feed rate was entered, the Position Counter may 
have displayed an incorrect value. 

 
3. Corrected a problem with arithmetic divide.  If the 

denominator was a user-defined variable with a negative 
value, the result would always be 0. 

 
4. Improved the reliability of the Diagnostics by slowing down 

the “Home to Limit” movement so that an overspeed condition 
does not occur. 

 
5. Modify the G82 Canned Cycle For Reducing Part Length 

function as follows: 
   - Allow I parameter (Z-Distance per cut).  If I is  
     specified, the number of cuts (Q Parameter) is  
     computed. 

- Allow X parameter of 0. 
- Allow Z parameter to be either positive (cut to the  

right) or negative (cut to the left). 



 
6. Display the default tool number and description in the 

status  
   bar on startup. 
 
7. Allow user-defined variables and arithmetic functions in 

the 
parameters of M-Codes.  Previously only G-Codes supported 
these functions. 

 
8. Added Pan and Zoom toolbar buttons.  If the Pan button is  

<Pressed>, then the Zoom button will be <Unpressed> and a 
Mouse Drag will cause the screen to Pan.  If the Zoom 
button is <Pressed>, then the Pan button will be 
<Unpressed> and a Mouse Drag event will cause the screen to 
Zoom. 

 
9. Improved the wait times while Loading and Saving very large 

CNC files.   
 
 

 
Date: Apr 2, 2007 
Subject: Enhancements resulting in revision 4.3.8 
By: Jeff Kidd 
 

1. Added Constant Surface Speed (CSS) functionality for the 
MN400 controller using the Fluxmaster 100 spindle 
controller.  G96 Sxxx will set a constant surface speed of 
xxx ft/min.  G97 Sxxx will cancel CSS and set a constant 
RPM of xxx.   G97 without an S-Param will cancel CSS and 
retain the current RPM setting. 

 
 
 
Date: Mar 29, 2007 
Subject: Enhancements resulting in revision 4.3.7 
By: Jeff Kidd 
 

1. Corrected problem with Backlash reinitializing at 
inappropriate times. 

 
2. End current “Continuous Contouring” stream when M00 

(Temporary Stop) or M06 (Tool Change) encountered. 
 
3. Corrected Error message when Fluxmaster spooling up. 

 
4. Reduced number of retries if Fluxmaster is not available. 
 
5.  Corrected bug detecting Windows VISTA Operating System. 



 
6.  Corrected bug detecting USB connection to MN400 

Controller. 
 
7.  Corrected Overflow error if Backlash value was too large. 
 
8.  Corrected problem updating the counters if Backlash used. 

 
9.  Retain “Measured Move” values after exiting MN400 Jog  

    screen. 
 
 10. Corrected bug when TMPFW does not prompt to save an unsaved 
    file. 

 
11. Corrected bug when “Save As” not marking file as saved. 

 
12. Clean up screen graphics on Machine Parameters – Jog Tab. 

 
13. Corrected “Run time error 5” if multiple pauses and restarts 

     were issued during a machine move. 
  

14. If the Spindle button pressed while in Graphics mode, we now 
    give the user the option of turning on Machine mode. 
    Previously, pressing the button would do nothing in Graphics 
    mode. 

  
15. If File | Open selected, then cancelled, do not ask the user  
    to “Restore Graphics ?”. 

 
16. Do not reset the counters after “Restore Graphics”. 

 
17. Corrected a problem during a Threading operation with the 

       Fluxmaster.  Previously, there was up to a one minute delay 
     between threading passes. 
 

18. Retain the last directory used in a “File | Open” menu 
    selection. 

 
 

 
 

 


